
IP Log for eclipse.platform 
Release 4.0, July 2010 

Licenses 

• Eclipse Public License v1.0 

Third-Party Code 

CQ Third-Party Code License Use 

1065 
ICU4J (core and extended 
function) and ICU4J 
Replacement plug-in Version: 3.6 

ICU4J License (X License, 
MIT Style) 

 

1116 ICU4J Version: 3.4.5.20061213 
ICU4J License (X License, 
MIT Style) 

 

1153 JSch 0.1.31 Version: 0.1.31 New BSD license  

243 
Apache Lucene Version: 1.9.1 
(Core+Contrib Analyzers 
Analysis Src) 

Apache License, 2.0  

257 APT Version: 1 New BSD license  

262 Cairo Version: 1.0.2 

Mozilla Public License 1.1 
(MPL), MIT Style with No 
Endorsement Clause, 
Historical Permissive Notice 
& Disclaimer 

 

280 ICU4J Version: 3.4 
ICU4J License (X License, 
MIT Style) 

 

281 ICU4J Version: 3.4.3 
ICU4J License (X License, 
MIT Style) 

 

293 jsch Version: 0.1.28 New BSD license  

308 PNG unload Version: 1 MIT license  

1232 Apache Ant Version: 1.7.0 Apache License, 2.0  

1367 
ICU4J and ICU4J Replacement 
Version: 3.6.1 

ICU4J License (X License, 
MIT Style) 

 

1368 
Olsen time zone data Version: 
2007e 

Public Domain  

1596 
Work derived from IJG JPEG 
Version: Release 6b,337 

IJG License   



1826 JSch 0.1.35 New BSD license 
unmodified 
source & binary 

1919 
ICU4J and ICU4J replacement 
Version: 3.8.1 

MIT License with "no 
edorsement" clause 

unmodified 
source & binary 

2014 jsch Version: 0.1.37 New BSD license 
unmodified 
source & binary 

2044 
XHTML DTDs Version: 
Versions 1.0 and 1.1 (PB CQ331) 

W3C Document License 
unmodified 
source  

2404 
org.apache.ant Version: 1.6.5 
(ATO CQ1013) (using Orbit 
CQ2209) 

Apache License, 2.0  

2405 
org.apache.lucene Version: 1.4.3 
(Core Source Only) (ATO 
CQ1014) (using Orbit CQ2210) 

Apache License, 2.0  

2406 
Junit Version: 3.8.2 (ATO 
CQ299) (using Orbit CQ2206) 

Common Public License 1.0  

2410 
Historical support for Java SSH 
Applet + Blowfish Version - v. - 
see comment in bug 

Custom Permissive License 
modified 
source & binary 

2411 
GTK Binding Version - 
Ganymede 

GNU Library or 'Lesser' 
General Public License 
(LGPL)  

unmodified 
source & binary 

2412 
GNOME Bindings Version - 
Ganymede 

GNU Library or 'Lesser' 
General Public License 
(LGPL) 

unmodified 
source & binary 

2413 
Mozilla Binding Version - 
Ganymede 

Mozilla Public License 1.1 
(MPL) 

unmodified 
source & binary 

2414 
Cairo Bindings Version - 
Ganymede 

Mozilla Public License 1.1 
(MPL) 

unmodified 
source & binary 

2476 
Apache Ant 1.7.1 (subset - see 
comment7) 

Apache License, 2.0 + W3C 
license 

 

2615 

Google Web Toolkit GWT 1.5: 
gwt-user.jar Version: 1.5.2 (Java 
files only, but excluding "plurals" 
folder) 

Apache License, 2.0 modified source  

2616 

Google Web Toolkit GWT 1.5: 
gwt-dev-linux.jar Version: 1.5.2 
(Java files only, but excluding 
"plurals" folder) 

Apache 2.0, New BSD 
license, NPL 1.1, EPL 1.0 

modified source  



2852 
Apache Batik Version: 1.6 **See 
Comments 6&7 re CSS SAC API 
(using Orbit CQ2070) 

Apache License, 2.0 
unmodified 
binary  

2868 
ICU4J and ICU4J replacement 
Version: 4.0.0 

MIT license with no 
endorsement clause, 
Unicode license 

unmodified 
source & binary 

2970 
ICU4J and ICU4J replacement 
Version: 4.0.1 

MIT license with no 
endorsement clause, 
Unicode license 

unmodified 
source & binary 

3052 
Jetty Version: 6.1.15 (Subset) 
(using Orbit CQ3031) 

Apache License, 2.0 + 
Custom Permissive OS 
Licenses 

unmodified 
source & binary 

3193 
JSch Version: 0.1.41 (PB 
CQ3040) 

New BSD license 
unmodified 
source & binary 

3254 
bottom-up heapsort C++ STL: 
SGI Silicon Graphics Inc 
stl_heap.h 

Modified NTP License  

3300 
XULRunner 1.9 SDK (Subset: 
two files) 

Mozilla Public License 1.1 
(MPL) 

 

3487 
ICU4J and ICU4J replacement 
Version: 4.0.1.v20090717 

MIT Style with "no 
endorsement" clause, 
Unicode license 

unmodified 
source & binary 

3555 
atinject (Package javax.inject) 
Version: 1.0 

Apache License, 2.0 
unmodified 
source & binary 

3583 
Apache Lucene Core Version: 
2.9.0 

Apache License, 2.0, Python 
Software Foundation 
License 

unmodified 
source & binary 

3703 

ICU4J Main* Version: 
4.0.1.v20100112 (*See 
comment9) (using Orbit 
CQ3697) 

MIT Style with "no 
endorsement" clause, 
Unicode license 

unmodified 
source & binary 

3699 
ICU4J and ICU4J replacement 
Version: 4.2.1.v20100112 

MIT License with "no 
endorsement" clause 

unmodified 
source & binary 

3704 

ICU4J Main* Version: 
3.8.1.v20100112 (*See 
comment4) (using Orbit 
CQ3698) 

MIT License with "no 
endorsement" clause 

unmodified 
source & binary 

3925 
ICU4J and ICU4J replacement 
Version: 4.2.1.v20100412 (using 
Orbit CQ3924) 

MIT License with "no 
endorsement" clause 

unmodified 
source & binary 



3935 
Jetty (Subset) Version: 6.1.23 
(ATO CQ3915) (using Orbit 
CQ3934) 

Apache License, 2.0, Eclipse 
Public License, Permissive 
Open Source Licenses 

modified 
source & binary 

3959 
geronimo-annotation_1.0_spec 
Version: 1.1.1 (ATO CQ3035) 
(using Orbit CQ3372) 

Apache License, 2.0 
unmodified 
binary  

4288 
xml-apis.jar Version: 1.3.04 
(ATO CQ1448) (using Orbit 
CQ2166) 

Apache License, 2.0, Public 
Domain, W3C 

 

Pre-Req Dependencies 

CQ Third-Party Code License Dependencies 

3736 
Operating System 
Version: Ongoing 

Various 
Exempt pre-
req 

3737 
Java Platform Standard 
Edition Version: 5 

Variable 
Exempt pre-
req 

3781 libsoup Version: 2.4 
GNU Library or 'Lesser' General 
Public License (LGPL) 

Exempt pre-
req 

3780 
WebKitGTK Version: 
1.1.19 

New BSD license, GNU Library or 
'Lesser' General Public License 
(LGPL) 

Exempt pre-
req 

Unused Approved Contributions 

CQ Third-Party Code License Status 

3797 
ICU4J and ICU4J replacement 
Version: 4.2.1.v20100212 

MIT License with 
"no endorsement" 
clause 

unused: not currently in 
use, but may be used in 
a future release 

3917 
ICU4J and ICU4J replacement 
Version: 4.2.1.v20100408 (using 
Orbit CQ3916) 

MIT License with 
"no endorsement" 
clause 

unused: not currently in 
use, but may be used in 
a future release 

Committers 

Past and Present Active 

Name Organization   

acovas  (not a current committer)   



airvine  (not a current committer)   

asharma  (not a current committer)   

bbokowsk  (not a current committer)   

bfarn  (not a current committer)   

briany  (not a current committer)   

bshingar  (not a current committer)   

celek  (not a current committer)   

chrix  (not a current committer)   

cknaus  (not a current committer)   

cmckillop  (not a current committer)   

cmclaren  (not a current committer)   

cvs  (not a current committer)   

daved  (not a current committer)   

davids  (not a current committer)   

dazad  (not a current committer)   

dbirsan  (not a current committer)   

dkehn  (not a current committer)   

dpollock  (not a current committer)   

droberts  (not a current committer)   

droberts2  (not a current committer)   

dwilson  (not a current committer)   

eduardo  (not a current committer)   

eidsness  (not a current committer)   

erich  (not a current committer)   

fbelling  (not a current committer)   

fhenze  (not a current committer)   

gmendel  (not a current committer)   

greg  (not a current committer)   

gunnar  (not a current committer)   

hmcfarla  (not a current committer)   

ibull  (not a current committer)   

ikhelifi  (not a current committer)   



janderson  (not a current committer)   

jarthanaree  (not a current committer)   

jbrown  (not a current committer)   

jburns  (not a current committer)   

jeromel  (not a current committer)   

jfogell  (not a current committer)   

jgarms  (not a current committer)   

jlebrun  (not a current committer)   

jonathan  (not a current committer)   

jszursze  (not a current committer)   

kcornell  (not a current committer)   

kdkelley  (not a current committer)   

khalsted  (not a current committer)   

kkolosow  (not a current committer)   

knutr  (not a current committer)   

kradloff  (not a current committer)   

lbourlier  (not a current committer)   

lchui  (not a current committer)   

lynne  (not a current committer)   

maeschlimann  (not a current committer)   

malice  (not a current committer)   

mfaraj  (not a current committer)   

mhuebscher  (not a current committer)   

mpawlowsk  (not a current committer)   

mvanmeek  (not a current committer)   

nhoda  (not a current committer)   

nkrambrock  (not a current committer)   

oconstan  (not a current committer)   

pdubroy  (not a current committer)   

randyg  (not a current committer)   

rperetti  (not a current committer)   

sarsenau  (not a current committer)   



sdimitro2  (not a current committer)   

seven  (not a current committer)   

skandula  (not a current committer)   

spingel  (not a current committer)   

ssarkar  (not a current committer)   

ssq  (not a current committer)   

teicher  (not a current committer)   

tellison  (not a current committer)   

tmaeder  (not a current committer)   

torres  (not a current committer)   

vlad  (not a current committer)   

wadman  (not a current committer)   

wchoi  (not a current committer)   

winchest  (not a current committer)   

wmtest  (not a current committer)   

Martin Aeschlimann IBM   

Chris Aniszczyk Red Hat, Inc.   

Adam Archer IBM   

John Arthorne IBM   

Chris Austin IBM   

Dirk Baeumer IBM   

Kevin Barnes   

Brian Bauman IBM   

Benno Baumgartner   

Serge Beauchamp Freescale Semiconductor   

Oleg Besedin IBM   

Billy Biggs   

Boris Bokowski IBM   

Nick Boldt Red Hat, Inc.   

Szymon Brandys IBM   

Ian Bull EclipseSource   

Ed Burnette SAS   



Jared Burns   

Samantha Chan IBM   

Rafael Chaves   

Semion Chichelnitsky IBM   

Christophe Cornu IBM   

Tod Creasey IBM   

Curtis D'Entremont IBM   

Krzysztof Daniel IBM   

Timothy Deboer IBM   

Jim Des Rivieres IBM   

Sonia Dimitrov IBM   

Rodney Dowdall   

Uttaran Dutta IBM   

Nick Edgar IBM   

Michael D. Elder IBM   

Frederic Fusier IBM   

Erich Gamma IBM   

Grant Gayed IBM   

Bogdan Gheorghe IBM   

Dejan Glozic IBM   

Chris Goldthorpe IBM   

Kevin Haaland IBM   

Matthew Hall   

Walter Harley   

Matthew Hatem IBM   

Felipe Heidrich IBM   

Tom Hofmann (nee Eicher)   

Kim Horne Research In Motion   

DJ Houghton IBM   

Anthony Hunter IBM   

Praveen Innamuri Adobe Systems   

Veronika Irvine   



Simon Kaegi IBM   

Gary Karasiuk IBM   

Markus Keller IBM   

Lina Kemmel IBM   

Adam Kiezun IBM   

Scott Kovatch IBM   

Lynne Kues   

Janek Lasocki-Biczysko   

Jean-Michel Lemieux IBM   

Carolyn MacLeod IBM   

Kai-Uwe Maetzel IBM   

Ovidio Jos?? Mallo   

Christof Marti   

Jeff McAffer EclipseSource   

Susan McCourt IBM   

Kevin McGuire   

Karice McIntyre IBM   

Dani Megert IBM   

Wassim Melhem   

Eric Moffatt IBM   

Kim Moir IBM   

James Moody   

Philippe Mulet IBM   

Duong Nguyen IBM   

Andrew Niefer IBM   

Steve Northover Bedarra Research Labs   

Martin Oberhuber Wind River   

Dave Orme   

Lorne Parsons IBM   

Rodrigo Peretti IBM   

Pawel Piech Wind River   

Pawel Pogorzelski IBM   



Silenio Quarti IBM   

Prakash Rangaraj IBM   

Pascal Rapicault Sonatype   

Michael Rennie IBM   

Brad Reynolds   

Thomas Schindl BestSolution   

Lakshmi Priya Shanmugam IBM   

Hitesh Soliwal IBM   

Remy Suen IBM   

Darin Swanson IBM   

Olivier Thomann IBM   

Branko Tripkovic   

Francis Upton IV   

Michael Valenta IBM   

Mikhail Voronin Intel Corporation   

Thomas Watson IBM   

Paul Webster IBM   

Andre Weinand IBM   

Tobias Widmer   

John Wiegand IBM   

Mike Wilson IBM   

Curtis Windatt IBM   

Darin Wright IBM   

Stefan Xenos   

Atsuhiko Yamanaka   

Tomasz Zarna IBM   

Never Active 

Name Organization   

Saurabh Agarwal IBM   

Manish Bhargava   

Kelvin Chan IBM   

John Duimovich IBM   



GowriSharmi Kandasamy Hewlett-Packard Company (HP)  

Oleg Krasilnikov   

Artyom Kuanbekov Intel Corporation   

Shailesh Patel   

Suresh Raju   

Hao Zhang IBM   

Contributors and Their Contributions 

Bug Size Description 

Benjamin Cabe (sierrawireless.com) 

252219 1.4K 
[DataBinding] [Databinding] Snippet000HelloWorld assume the Person 
model is a bean but it's only a POJO... 
patch against org.eclipse.jface.examples.databinding 

255466 1.4K 
[Forms]MessageManager.Message.equals() returns incorrect results 
because of missing parentheses 
Patch 

265532 3.2K 
org.eclipse.core.runtime.Platform.knownWSValues() doesn't include 
cocoa 
patch to add cocoa to WS list 

Antoine Toulme (lunar-ocean.com) 

249313 855 
[TabbedProperties] [properties.tabbed]The label on the extension point 
propertyTab is not marked as translatable 
properties.tabbed plugin tab label patch 

Prakash G.R. (gmail.com) 

210491 872 
[Mac] FilteredItemsSelectionDialog can use SWT.SEARCH attribute 
Fix for the bug 

Prakash G.R. (in.ibm.com) 

150626 6.8K 
[Import/Export] Create working sets when importing several projects. 
Patch v02 

221980 16.6K 
[Contributions] [Contributions] MenuItems with style radio are not 
initialized in context menu 
Radio State patch v02 

221980 11.0K 
[Contributions] [Contributions] MenuItems with style radio are not 
initialized in context menu 
Patch 01 for toggle state 

226746 73.5K [Commands] Handler updates UI using wrong selection after right-click 



in different view 
Patch v03 

226746 8.0K 
[Commands] Handler updates UI using wrong selection after right-click 
in different view 
Tests v02 

231304 14.9K 

[Contributions] Tooltip for Menu Contributions placed on toolbar: does 
not include keybinding sequence(inconsistency in migrating from 
ActionSets to MenuContributions) 
v04 - patch based on v03 

231304 6.0K 

[Contributions] Tooltip for Menu Contributions placed on toolbar: does 
not include keybinding sequence(inconsistency in migrating from 
ActionSets to MenuContributions) 
Test v01 

238397 8.7K 
[Commands] Concurrent modification possible in 
DefaultOperationHistory 
Patch v02 

241849 22.2K 
[Markers] Need a property tester to test the marker type of a 
MarkerEntry 
Patch with tests 

246999 8.5K 
[Contributions] menuContribution/dynamic element cause plugin 
startup 
Reattaching patch with Paul's suggestions implemented 

246999 9.3K 
[Contributions] menuContribution/dynamic element cause plugin 
startup 
Tests v03 

248733 742 
Expression is not evaluated at startup 
Patch v01 

248752 41.6K 
[KeyBindings] provide general platform transform for sequence 
modifiers in org.eclipse.ui.bindings 
Patch v03 

249442 1.9K 
[Contributions] VisibleWhen with checkedEnabled expression on 
menuContribution 
Patch v02 

249574 822 
[Contributions] ExternalActionManager.addPropertyChangeListener() 
doesn't register the ListenerList 
Fix for the bug 

250133 26.6K 
[Contexts] ContextAction's leak when hiding actions sets 
Patch v04 

250136 12.9K 
[KeyBindings] Conflicts should be accessible through API 
Patch v02 



251001 5.7K 
[Commands] Removed unused Action classes related to Update 
Manager 
Patch v01 

254492 966 
[Import/Export] ILeveledImportStructureProvider interface is not 
declared public 
Patch v01 

254550 1.5K 
[IDE] NPE in SaveAsDialog when IDE not running 
Patch v01 

254984 15.6K 
[Progress] IWorkbenchSiteProgressService's schedule(Job, long, 
boolean) method ignores third parameter after the first call 
Patch v03 + Tests 

255172 16.5K 
[Import/Export] Warning message in the import wizard is not so helpful 
Patch v04 

255393 771 
[Import/Export] Browse button missing for the export wizard icon field 
(plugin.xml editor) 
Patch 

256556 1.0K 
[Progress] Possibly broken code in DetailedProgressViewer.setFocus 
Patch v01 

258352 8.9K 
[Progress] synchronization in ProgressManager too expensive 
Patch v02 

259821 2.7K 
[Contributions] commandImages does not support 'platform:/plugin/' 
resource spec for icon 
Patch v01 

259954 3.0K 
[Import/Export] Warning should be displayed when no projects are 
available in the archive/directory 
Path v01 

263690 9.4K 
[Commands] Command that can throw a CoreException during 
execution is considered successfully run 
Patch v01 

263855 9.9K 
[Import/Export] [Wizards] Request Project Import Wizard allow for an 
initial / pre-populated path 
Patch v03 + tests 

264845 2.1K 
[Contributions] WorkbenchServiceRegistry fails with 
ArrayStoreException 
Patch v02 

265159 834 
[Import/Export] When user double clicks on an item in the Import 
Wizard 2 calls are made to showPage 
Patch  

267408 2.9K 
[Contributions] RadioState should work like RegistryToggleState 
Patch v01 



Paul Adams (ittvis.com) 

202534 501 
[Dialogs] SWT error in Wizard dialog when help is displayed and 
"Finish" is pressed 
Patch for 3.4.2 - bug 202534 

Heiko Ahlig (gmx.de) 

267712 11.2K 
[DataBinding] add ObservableMapCellLabelProvider 
Example for the ObservableMapCellLabelProvider 

Raji Akella (us.ibm.com) 

246285 1.9K 
[Help] Null Pointer exceptions in ReusableHelpPart.java and 
SearchPart.java 
Patch 

Corey Ashford (us.ibm.com) 

177400 938 
4 failures in org.eclipse.core.tests.resources 
Fixes problem with clsConvert object being garbage collected between 
calls to getString 

Chris Audley (yahoo.com) 

273265 1.6K 
[DataBinding] ChangeManager doesn't support Cloneable 
Adds a clone method to ChangeManager 

Chris Austin (us.ibm.com) 

241885 13.8K 
[Intro]Option to always launch to Welcome until user chooses not to 
Patch - Second Generation 

249921 34.2K 
[Help] 'Content' preference page has awful dialogs 
Patch for updated dialogs 

249924 4.2K 
[Help] 'Content' preference page uses a TabFolder when there is only 
one item 
Patch without the tab 

263855 8.1K 
[Import/Export] [Wizards] Request Project Import Wizard allow for an 
initial / pre-populated path 
Second generation implementation 

272974 8.3K 
[Help] 'Content' preference page 'Restore Defaults' button clears out 
infocenter list regardless of defaults 
Initial fix implementation 

280357 7.5K 
[Help][Context] Tools to create, debug, edit context sensitive help 
(CSH) 
Patch V3 

290147 1.1K 
[Help] Remote Help and unescaped characters in path 
Patch V1 

291639 2.3K [Help][Context] Dead code in ContextManager 



Patch to remove obsolete code 

308604 2.5K 
3 warnings in official build 
Patch to fix compile warnings 

310844 6.6K 
[Help] Steps to convert infocenter to WAR are incorrect 
Patch to fix webapp directory strcuture and doc 

311791 4.1K 

For infocenters running on Eclipse 3.5 and earlier, requests to /rtopic 
return the page not found input stream, instead of returning 
SC_NOCONTENT, causing remote help priority to display Topic not 
found pages even if the doc is not on the infocenter. 
Patch V3 

Deepak Azad (in.ibm.com) 

267427 1.3K 
[printing] File -> Print... should use new PrintDialog.setPrinterData() 
API 
reworked patch 

272172 15.4K 
[rulers][hovering] Add a command that allows to show the vertical ruler 
hover 
fix 

273012 690 
[Forms] NPE in FormPage.setActive(...) 
Proposed patch to ffix the bug by adding a null check 

277684 6.5K 
[preferences] Add comment to pref page that changing quick diff 
provider does not update open editors 
reworked patch with the suggested changes 

293237 4.9K 
[implementation] Clean up usages of new GridData(int) in 
QuickDiffConfigurationBlock.java 
patch 

Natalia Bartol (pl.ibm.com) 

256942 7.8K 
Using file_prompt for Ant script produces confusing results 
AntPrompts_v.2.0 

John J. Barton (johnjbarton.com) 

248516 2.7K 
[Browser] Update Window > Pref > General >Web Browsers UI 
patch to BrowserDescriptorDialog allowing long parameter lists and 
setting inital size based on incoming text 

Wayne Beaton (eclipse.org) 

208609 1.5K 
Bug in ErrorRecoveryLog.getLocalRandomIdentifier(String path) 
JUnit test case 

293085 1.2K 
UnixProxyProvider throwing "Too many open files" exception 
Patch adds call to Process.destroy() 

Serge Beauchamp (freescale.com) 



317783 1.0K 
Resource filters do not work in CDT 7.0 projects 
Patch for the CDT (to make it work until the Platform is patched) 

Baltasar Belyavsky (ti.com) 

300713 3.1K 
[Preferences] [Jface] Add ability to set the filter-path on file/directory 
field-editors 
patch - applies to workspace 

Matthew Bisson (ca.ibm.com) 

181308 33.7K 
[Viewers] Add checked state provider to CheckBox*Viewer 
ICheckStateProvider - interface, modified Check*Viewers, tests 

182714 33.7K 
[Contributions] Improve toolbar configurability 
ICheckStateProvider - final? 

182714 234.0K 
[Contributions] Improve toolbar configurability 
Customize Perspective Dialog UI and Logic - revised 

182714 23.5K 
[Contributions] Improve toolbar configurability 
Tests for TreeManager 

258153 3.6K 
Making a wizard visible in CPD does not make the New menu visible. 
Final fix 

258934 4.3K 
[Viewers] Improve CheckboxTreeViewer coverage 
More CheckboxTreeViewer tests 

258934 7.5K 
[Viewers] Improve CheckboxTreeViewer coverage 
More CheckboxTableViewer tests 

258934 4.9K 
[Viewers] Improve CheckboxTreeViewer coverage 
More StructuredViewer Tests 

Andreas Bjoru (bjoru.com) 

158642 8.0K 
[Workbench] Hide toolbar not persisted 
using preferences and fixes toggle command issues 

David Black (workday.com) 

198091 1.2K 
[LinkedResources] Error logged when opening Properties dlg on a 
Linked Resource folder involving a path variable 
Proposed change to fix 198091 

James Blackburn (gmail.com) 

86973 10.2K 
[Dialogs][IDE] Open Resource dialog should accept pattern for 
matching folder path 
patch 3 

230842 980 
[Help] new Toc(IToc ...) does not copy over the linkTo field 
Patch to setLinkTo when IToc is converted to Toc in TocManager 

265235 1.2K 
Project reconcileLinks always delete's linked resource if resource 
contains a variable 



Patch 1 

305529 1.1K 
[Markers] NPE in MarkerFieldEditor if MarkerFieldConfiguration 
scope is unset 
trivial patch 

306822 4.0K 
We need context for IncrementalProjectBuilder#getRule() 
patch 1 

306824 14.5K 
Builders returning null scheduling rule can't work safely with other 
builders overriding #getRule() 
test 1 

307282 5.1K 
ILock#acquire(int) broken after interrupt() => OrderedLocks become 
lost 
test 2 

307391 5.3K 
IllegalArgumentException Cannot yieldRule job that is YIELDING 
simplified test + patch 

311863 4.8K 
OrderedLock: interrupting during acquire can lead to deadlock 
test 4 

311863 2.2K 
OrderedLock: interrupting during acquire can lead to deadlock 
patch 3 

Alex Blewitt (gmail.com) 

210826 827 
Enabled on NSButton seems to have no effect 
Enables the button.enable to work 

Nikolay Botev (hotmail.com) 

240651 20.6K 
[EditorMgmt] Introduce AbstractMultiEditor 
updated patch... 

Chuck Bridgham (us.ibm.com) 

218127 6.9K 
[CommonNavigator] Common Navigator inherited viewer bindings 
Suggested implementation patch 

Alban Browaeys (yahoo.com) 

242788 914 
a lot of popup ends up as null error 
check if the parent is disposed before setting the parent as the shell (and 
use display instead if so) 

250707 977 

[Proxy] remains an issue : if gnome proxy is set to direct connection pd 
is null and the java code does not handle that 
Fix the bug about gnome direct connection triggering a null pointer 
exception 

Keith W. Campbell (ca.ibm.com) 

235018 1.2K 
[Markers] Regression: Columns in Problems view grow wider with each 
restart 



proposed patch 

Matt Carter (baselib.org) 

180392 9.5K 
[DataBinding] Add support for shorts, bytes, and BigDecimal to 
StringToNumberConverter 
Unit Tests 

180392 14.8K 
[DataBinding] Add support for shorts, bytes, and BigDecimal to 
StringToNumberConverter 
Patch updated for CVS HEAD 

Peter Centgraf (centgraf.net) 

251575 1.4K 
[Viewers] TableViewer support for virtual selection 
TableViewer with more efficient setSelection() implementation 

251575 715 
[Viewers] TableViewer support for virtual selection 
Proposed mixin interface 

Mariot Chauvin (obeo.fr) 

259553 2.1K 
[TabbedProperties] expensive refresh of text 
patch for the 3.4 branch 

Simon Chemouil (mithrandir.net) 

293044 2.6K 
[QuickAccess] Ability to show bound keys in Quick Access list 
Revision according to Paul Webster's comment 

Patrick Chuong (ti.com) 

238956 188.6K 
Improve usability of the breakpoints view 
Updated patch with bug fixes for FlexBreakpointView branch 

238956 2.3K 
Improve usability of the breakpoints view 
Copy & Paste fix 

238956 158.6K 
Improve usability of the breakpoints view 
Add comments to interfaces/classes methods and fields (lines of code = 
208) 

286310 18.1K 
Checkbox support for Flexible Hierachy view 
Check Event notification on the model proxy 

306768 8.0K 
ElementLabelProvider doesn't handle mixed label provider properly 
fix 

John Cortell (freescale.com) 

263535 1.6K 
resolution of ${eclipse_home} inconsistent with other vars like 
${workspace_loc} 
possible fix 

289409 3.1K 
[Viewers] ILazyTreePathContentProvider documentation request 
Proposed javadoc enhancement 



292301 3.5K 
Incorrect @see tags in LabelUpdate and Request 
fix 

292465 1.1K 
Terminate and Remove action was broken by 284363 
fix 

292480 6.9K 
Terminate and Relaunch does not properly support custom models 
fix 

292480 8.3K 
Terminate and Relaunch does not properly support custom models 
new patch 

Livar Cunha (gmail.com) 

236049 1.1K 
[console] 'Clear' context menu item enable when no text is available to 
be cleared 
Patch to solve this bug 

Christopher Daniel (pl.ibm.com) 

230349 14.3K 
[StatusHandling] Status label provider should not be disposed when its 
modality is switched 
Fix with improved test 

235354 3.5K 

[ErrorHandling] [StatusHandling] 
WorkbenchStatusDialogManager#setStatusListLabelProvider() does not 
work 
Slightly modified fix 

243148 13.5K 
[StatusHandling][TestTool] Testtool should allow for setting message 
and title of the reported status 
Patch 

247933 2.5K 
[StatusHandling] During the modality switch the state of details/support 
is not preserved correctly 
Fix 

249272 1.5K 
[StatusHandling] Clipboard in WSDM is never used 
Fix 

251193 1.3K 
closing the WorkbenchWindow causes the RectangleAnimation to fail 
Updated fix 

Sebastian Davids (gmx.de) 

137478 7.0K 
[Preferences] ProjectReferencePage has too wide left margin 
fix 

Carlos Devoto (compuware.com) 

213645 26.9K 
[RCP] Requesting programmatic hook to create view folders that 
remain visible after their last child is closed 
Updated patch 

Martin Donnelly (eircom.net) 



145997 1.1K 

[Forms] FormText::computeTextSize returns incorrect date for 
horizontal size 
Small change to FormText.computeTextSize() method that modifies 
logic for computing horizontal size 

Doug (ymail.com) 

243053 5.1K 
Tabs added via launchConfigurationTabs cannot be placed after each 
other 
A patch that fixes the issue 

277299 1.3K 
[implementation] Performance issue with jface text WordRule 
WordRule performance patch 

280053 1.7K 
[Build] Build shouldn't allocate progress for closed projects 
Patch for BuildManager 

Johann Draschwandtner (windriver.com) 

300988 9.3K 
[api] The StringVariableSelectionDialog for core.variables should 
support filtering 
revised patch 

304752 5.9K 
Improve UI for String variable selection dialog filters 
patch 

Kristian Duske (gmail.com) 

223390 1.4K 
flat and border button in swt do not work 
Enables SWT.FLAT for Cocoa Buttons. 

Ralf Ebert (ralfebert.de) 

294738 1.1K 
[Viewers] (JFace) Assertion for missing LabelProvider in 
ViewerColumn 
added assertion 

Murat Eken (users.sourceforge.net) 

204837 1.3K 
[CommonNavigator] commonWizard with no pages displays empty 
dialog 
Contains a fix for this issue 

Hannes Erven (erven.at) 

293841 131 

[FieldAssist] NumLock keyDown event should not close the proposal 
popup [with patch] 
Suggested patch that adds SWT.NUM_LOCK to ignored keyDown 
events in popup 

Mike Evans (incremental.eu.com) 

283136 1.0K 
[Intro] AlwaysWelcomeCheckbox - incorrect URL when creating 
HTML content 
patch for AlwaysWelcomeCheckbox java file 



Ryan Fong (trapezenetworks.com) 

201143 2.4K 
exported ant script does not apply include/exclude filter on init target's 
copy task 
proposed patch v2 

Leif Frenzel (leiffrenzel.de) 

206272 935 
Typo in extension point example 
Suggested patch 

Martin Frey (logica.com) 

256150 3.8K 
[DataBinding] Databinding of Interfaces 
Patchfile 

Daniel Friederich (freescale.com) 

238956 13.7K 
Improve usability of the breakpoints view 
Font for default working set and also fix for update when default 
changes (lines of code = 104) 

238956 1.0K 
Improve usability of the breakpoints view 
Fix for empty input when switching perspectives 

241336 9.3K 

[flexible hierarchy] IModelProxyFactory.createModelProxy() should 
take the full path to element. 
Adds IModelProxyFactory2 which is used to install per path model 
proxies. 

293210 919 
Context launch launches shared launch configuration twice. 
fix merge bug in pref patch 

293844 13.0K 
Problematic order of handling of INSERTED/ADDED/REMOVED and 
other non model changing flags 
Test for change 

Peter Friese (itemis.de) 

208602 3.6K 
[Dialogs] Open Type dialog needs accessible labels 
Patch for bug 208602 

Sebastian Fuchs (gmail.com) 

243848 1.0K 
[DataBinding] [WritableList] Typo in JavaDoc 
Patch for constructor's JavaDoc 

Wojciech Galanciak (pl.ibm.com) 

236104 1.9K 
[EditorMgmt] File association default needs to be set twice to take 
effect 
proposed solutions v3.6 

291339 6.1K 
validateEdit not called for launch configuration stored locally 
updated patch with run cancel 

294868 851 [Forms] Problem with text wrapping in SharedScrolledComposite 



proposed solution 

302163 26.4K 
[Sync View] Error message during update operation after 
synchronization 
testcase 

Lidija Grahek (ca.ibm.com) 

245155 1.3K 
[TabbedProperties] IllegalArgumentException: Argument not valid 
Patch 

256516 4.0K 
[TabbedProperties] TabbedPropertySheetPage to allow some options 
Patch 

259179 3.5K 
[TabbedProperties] TabbedPropertySheetPage extensibility option 
Patch 

David Green (tasktop.com) 

301196 5.9K 
[FieldAssist] ContentAssistCommandAdapter should provide an 
activation expression when activating the command handler 
the unit test was committed, but not the patch to the code. 

Chris Grindstaff (gstaff.org) 

251528 682 
SWT Image created without GDI tracking 
Patch to add GDI tracking to Image 

Alexander Gurov (mail.ru) 

230853 3.5K 
Sometime resources are disappeared from Synchronize View 
Fix for Synchronize View refresh issues 

Micah Hainline (yahoo.com) 

208160 9.2K 
[JFace] Request for RowLayoutFactory 
RowLayoutFactory 

Helena Halperin (il.ibm.com) 

298747 1.3K 
[EditorMgmt] Bidi Incorrect file type direction in mirrored "Editor 
Selection" dialog 
patch 

299031 1.9K 
[Preferences] BIDI_BDL: Incorrect file path display in Recent 
workspaces list of Preferences dialog 
patch 

299212 4.1K 
[Preferences] BIDI_BDL: Incorrect path display in Linked Resources 
list of Preferences dialog 
new patch 

Kari Halsted (ca.ibm.com) 

250502 2.5K 
Tables of (default) accessibility keyboard shortcuts 
Proposed patch for updates to keybindings topic 



Matthew Hatem (notesdev.ibm.com) 

273495 5.1K 
[ActionSets] Actionsets leak when opening/closing perspectives 
Updated Patch  

Dan Heidinga (ca.ibm.com) 

134190 709 
[JFace] NPE in StatusLine class 
One Line fix for NPE in #subTask(String) 

240985 1.3K 
NPE adding org.eclipse.ui.console.consolePageParticipants extension 
without enablement clause 
Checks for null enablement expression 

246278 1.2K 
NPE in DefaultDetailPane.java:264 
Slightly better fix then previous patch 

249514 1.0K 
[Viewers] [JFace] NPE setting StructuredSelection(Object[]) 
Assert added and javadoc updated 

Stephan Herrmann (cs.tu-berlin.de) 

255556 728 
[Contributions] Extension point org.eclipse.ui.popupMenus has a typo: 
java.lang.object 
patch 

291695 2.2K 
Element compare fails to use source range 
improved patch 

296580 3.0K 
[compare] Java Compare Editor: 'Copy Current Change from Right to 
Left' garbles contents 
patch 2 

Gordon Hirsch (sas.com) 

214532 20.2K 
[JFace] Open up the API for 
org.eclipse.jface.layout.AbstractColumnLayout 
patch to make abstract methods protected 

Hitesh (in.ibm.com) 

212583 13.0K 
[WorkingSets] Changing name(or label) of WorkingSet breaks logic of 
TreeSet where WorkingSetManager stores WorkingSets. 
Patch v1 

217906 4.1K 
[WorkingSets] IWorkingSetManager.createWorkingSetSelectionDialog 
javadoc states wrong behavior 
Patch 1 

228110 4.2K 
[Markers] Problems view: Improve 'Warnings on Selection' 
Patch 1 

229782 3.6K 
Performance tests for ICU Collator 
Patch 1 

235802 4.3K [Markers] Marker testResourceMappings failure in I20080604-2000 on 



linux java 5.0 
Fix v01 

242208 3.3K 
[Markers] Filtering problems by working set doesn't take into account 
new files 
Patch 

250807 4.4K 
[Markers] Delete handler in problems view should spawn a job 
Patch 2 

251195 3.5K 
[Markers] Quick fix is not available in Markers view 
patch handler and command 

256561 1.0K 
[WorkingSets] Possibly broken code in 
ModifyWorkingSetDelegate.getItems() 
Patch 1 

257094 2.0K 
[Markers] NPE in MarkerHelpRegistry 
Check Null 

257956 7.6K 
[Markers] Improvement requests to Problems View / Configure 
Contents dialog 
Patch 2 

258810 6.3K 
[Markers] Markers for the entire workspace show up when working set 
empty 
Patch 2 

261861 1.7K 
[Markers] QuickFix dialog doesn't show Location properly 
patch 

274631 1.3K 
[WorkingSets] Save/restore of aggregate workingset broken by changes 
from Bug 217955. 
Possible patch 

274631 6.1K 
[WorkingSets] Save/restore of aggregate workingset broken by changes 
from Bug 217955. 
Corrected Test 

Marc R. Hoffmann (mountainminds.com) 

54581 19.2K 
[GlobalActions] Provide API constants for 
actionDefinitionIDs/commandIDs 
IWorkbenchCommandConstants.java 

284265 7.4K 
[JFace] DialogSettings.save() silently ignores IOException 
patch.txt 

Mark Hoffmann (web.de) 

84603 2.7K 
[RCP] [PerspectiveBar] New API or pref to set default perspective bar 
size 
Patch proposal for setting the default size via plugin_customization.ini 

Chris Horneck (yahoo.com) 



287765 5.4K 
[Viewers] getExpandedTreePaths in AbstractTreeViewer can fail when 
there are items with dummy children 
TestCase to reproduce the error 

Bryan Hunt (mac.com) 

245457 1.2K 
[Forms] ExpandableComposite should have option of not drawing the 
title focus box 
NO_TITLE_FOCUS_BOX 

Guillermo Hurtado (us.ibm.com) 

27343 7.1K 
[Help] TOC tag does not support icon="Myimage.gif" 
org.eclipse.help.ui plug-in dynamic help view patch 

27343 16.1K 
[Help] TOC tag does not support icon="Myimage.gif" 
Icon contribution to help webapp 

Min Idzelis (us.ibm.com) 

283449 100.0K 
[Jobs] Add ability to temporarily yield a Job so that blocked jobs are 
given a chance to execute. 
v11 

293308 1.0K 
ILock.acquire() doesn't restore interrupts 
Restore interrupts if interrupted during acquire() 

293512 2.2K 
[Workbench] Make IWorkbench into an OSGi service 
My proposal 

312334 4.4K 

Implicit Jobs (ThreadJobs) in some circumstances are automatically run 
twice. Resuming from a yieldRule() cause jobs to be rescheduled. 
Job.schedule() should have no effect for ThreadJob. Job.yieldRule() for 
ThreadJob does not find blocked explicit Jobs. 
Fix v1 

312334 8.9K 

Implicit Jobs (ThreadJobs) in some circumstances are automatically run 
twice. Resuming from a yieldRule() cause jobs to be rescheduled. 
Job.schedule() should have no effect for ThreadJob. Job.yieldRule() for 
ThreadJob does not find blocked explicit Jobs. 
Regression Junits 

Mickael Istria (bonitasoft.com) 

274554 804 
[Contributions] StatusLineManager: NullPointerException in 
setCanceled(...) 
Proposed patch 

Brock Janiczak (tpg.com.au) 

283295 780 
Associate presentation actions bar with Ant Editor 
Patch to add Editor Presentation action bar to the ant editor 

Mikhail Kalugin (gmail.com) 

230119 5.9K Keyboard navigation in the StyledText (Cocoa) 



Keyboard modifiers handling for Cocoa 

230120 7.2K 
Mouse scrolling support in Cocoa applications 
Mouse scrolling support for Cocoa 

232685 1.4K 
ScrollBar works incorrectly with StyledText 
Fix for ScrollBar (setValues() and setEnabled() implementations) 

Martin Karpisek (googlemail.com) 

195840 4.7K 
Import a XML file with BOM character in ant editor fails 
patch 

Krzysztof Kazmierczyk (cs.put.poznan.pl) 

300174 821 
[Browser] Problem with refreshing pages in internal web browser when 
IE8 installed 
patch-3.6 

Marc Khouzam (ericsson.com) 

284587 1.3K 
Reference to CDT in toggleBreakpointsTargetFactories extension point 
Suggested fix 

294553 1.8K 
toggleBreakpointsTargetFactories extension point does not respect 
ActionSet 
Add workbench IEvaluationContext as a parent 

313143 1.3K 
Preferred Launch Delegate not recovered from preferences 
Proposed fix 

Konstantin Komissarchik (oracle.com) 

242583 989 
[About] Feature info text area in about dialog does not wrap text 
Patch 

316997 829 
[Forms] FormText: IllegalArgumentException when copying empty 
selection - Fix in Eclipse 3.6.1 
Patch 

Andrew Konchakov (borland.com) 

228354 3.1K 
Folder deletion can cause incorrect project delta node flags if linked 
folders exist in project 
comment #0 

Robert Konigsberg (google.com) 

260766 2.1K 
Javadoc bugs in org.eclipse.core.resources plug-in 
javadoc for Workspace.java and ElementTreeIterator.java 

Blazej Kroll (gmail.com) 

225749 17.0K 
[Wizards] Creating working sets from Import > Project from CVS 
wizard 
Add to working sets mechanism added 



Mayank Kumar (gmail.com) 

126705 739 
[Preferences] FileFieldEditor does not call doCheckState 
Fixed patch 

Markus Alexander Kuppe (lemmster.de) 

248103 77.9K 
[PropertiesView] Multi-instance Properties View 
version 7 

Alena Laskavaia (gmail.com) 

2035 2.3K 
[Wizards] Previous location of project content area not remembered 
(1GDQUX8) 
Patch 

259281 2.0K 
[launch] When using Environment tab it does not process variables with 
newline correctly 
proposed patch 

Anton Leherbauer (windriver.com) 

161095 643 
[CommonNavigator] Drag and Drop of non IResource items causes 
FileTransfer to be created with null data 
Proposed fix 

178203 1.8K 
[projection] Eclipse is too eager to unfold code 
Suggested fix 

198591 4.4K 
[Build] Builder should be able to specify scheduling rule 
Combined patch for core.resources with contributor line 

217801 1.2K 
[CommonNavigator] Capability filtering of commonWizard extensions 
uses wrong identifier 
Use wizardId as contribution id 

220599 2.5K 
[CommonNavigator] Project Explorer does not support Navigate > 
Show In... 
Proposed fix #2 

247294 4.2K 
[CommonNavigator] Project Explorer: ResourceDragAdapterAssistant 
always initiates drag of resources 
Proposed fix 

251224 2.7K 
[misc] Allow custom token for WhitespaceRule 
New constructor 

251224 891 
[misc] Allow custom token for WhitespaceRule 
Patch against JavaCodeScanner only 

251224 869 
[misc] Allow custom token for WhitespaceRule 
Patch against JavaDocScanner only 

251711 2.5K 
Select All should not select invisible items 
Proposed fix 



254442 18.7K 
"Create Watch Expression" action does not appear consistently 
Simplified new API 

255153 887 
Select All does not fire selection change event 
Force a selection change event 

255422 865 
[Contributions] Toolbar painting issues when a command is contributed 
to the menu 
Simple fix 

261031 1.1K 
[CommonNavigator] IPipelinedContentProvider getParent() returning 
the suggested parent is not ignored 
Patch proposal 

292664 2.9K 
[implementation] CopyOnWriteTextStore leaks memory 
Improved fix 

296800 4.3K 
[GlobalActions] UI build actions should not lock the workspace 
Patch for BuildAction and GlobalBuildAction 

300664 9.2K 
[GlobalActions] Make 'Build All' retargetable 
'Build all' as default command handler 

301023 6.4K 
[projection][typing] "Backspace" key deleting something else 
Previous fix + additional tests 

305858 2.8K 
IncrementalProjectBuilder.getRule() should be allowed to return null 
Suggested fix 

306824 1.7K 
Builders returning null scheduling rule can't work safely with other 
builders overriding #getRule() 
Fall back to workspace root if rule-less builder is not "alone" 

Stefan Liebig (compeople.de) 

242685 1.9K 
StringVariableManager - Variable contributions may silently override 
existing variables 
Checks ´overridden´ variables from extensions 

Jamie Liu (us.ibm.com) 

172692 4.5K 
[About] About dialog text - Add capability to read system properties 
patch in which message formatting is done only once 

Andrei Loskutov (gmx.de) 

268676 5.8K 
[PropertiesView] pinning is not working (well) with tabbed properties 
Updated patch without tests 

278514 784 
[WorkbenchParts] NPE in PageBookView.containsPart 
A simple patch 

Luma (cn.ibm.com) 

211360 1.0K 
Graphics example can't select items from tree-menu 
Patch 



Francis Lynch (windriver.com) 

301563 22.2K 
Fast project import from snapshot data 
Patch v5 to org.clipse.core.resources plugin 

303751 73.9K 
[Import/Export] Need a UI for fast project import from snapshot data 
Patch version 5 org.eclipse.ui.ide with import/export wizards 

305716 12.9K 
Add Unittests for fast project import from snapshot data 
Patch to org.eclipse.core.tests.resources 

305718 2.5K 
Cannot rename a project on fast project import from snapshot 
Additional patch to org.eclipse.core.tests.resources 

305718 10.5K 
Cannot rename a project on fast project import from snapshot 
Patch version 2 to org.eclipse.core.resources 

305718 2.7K 
Cannot rename a project on fast project import from snapshot 
Patch to ProjectSnapshotTest to add another rename test 

307985 1.9K 
ProjectSnapshotTest.#testLoadWithRefresh fails in N20100331-2000 
and N20100401-2000 
Patch to org.eclipse.core.tests.resources 

307985 2.4K 
ProjectSnapshotTest.#testLoadWithRefresh fails in N20100331-2000 
and N20100401-2000 
Patch version 2 to org.eclipse.core.tests.resources 

Piotr Maj (jcake.com) 

296439 6.2K 
[templates] Hard to extend Templates View - no access to template 
store and current selection 
proposed solution using ITemplatesPageExtension 

Ovidio Mallo (gmail.com) 

235195 6.3K 
[Wizards] [DataBinding] Non-error statuses not handled correctly by 
WizardPageSupport class 
Proposed patch along with a simple unit test 

235859 6.2K 
[DataBinding] MultiValidator: Add support for dependencies other than 
those expressed by IObservables 
re-posting the patch 

237163 8.6K 
[DataBinding] UnmodifiableObservableValue should delegate the 
isStale() method to its wrapped value. 
proposed patch along with some unit tests 

237856 9.4K 
[Wizards] [DataBinding] WizardPageSupport class should track the 
staleness state of relevant observables 
proposed patch for the WizardPageSupport part 

238909 14.8K 
[DataBinding] Correctly set the staleness state of the validation status 
observable of the MultiValidator 
new patch with the just mentioned fix 



241318 13.1K 
[DataBinding] DetailObservable(Value|List|Set) disposes the master 
observable in its own dispose() method 
simple patch along with tests for the three detail observables 

242166 2.4K 
[DataBinding] Add StaleEventTracker class to conformance tests 
patch (just a copy of ChangeEventTracker) 

247741 35.9K 

[DataBinding] Consequently use *EventTracker classes from 
conformance tests API in unit tests 
patch which replaces custom listeners by their *EventTracker 
equivalent whenever possible 

251003 2.2K 
[DataBinding] MultiValidator misses some dependencies 
simple unit test illustrating the problem 

Lubomir Marinov (gmail.com) 

182122 687 

[Dialogs] 
CheckedTreeSelectionDialog#createSelectionButtons(Composite) fails 
to align the selection buttons to the right 
Tries to fix the first of the two described problems 

182122 698 

[Dialogs] 
CheckedTreeSelectionDialog#createSelectionButtons(Composite) fails 
to align the selection buttons to the right 
Tries to fix the second of the two described problems 

Brian Mauter (gmail.com) 

248333 7.6K 
[Watch/Edit] Team Show Editors grid is not sortable 
patch file to add sorting to Team Editors grid 

Chris McGee (ca.ibm.com) 

266538 3.6K 
[expressions] [Contributions] Performance degredation in expand all in 
the project explorer 
Proposed Fix #2 (WeakHashMap) 

gloria.s.goyena@sybase.com 

289161 2.5K 
[Webapp] In large infocenter, creating new search scope causes IE 
browser to hang. 
Patch for org.eclipse.help.webapp/advanced/workingSet.jsp 

Stephan Merker (sap.com) 

208609 665 
Bug in ErrorRecoveryLog.getLocalRandomIdentifier(String path) 
Patch for bug in ErrorRecoveryLog.java 

Lars Millberg (saabgroup.com) 

255200 7.4K 
[Project Sets] Missing "Merge All" in "Import Project Set" 
Patch v2 

Shawn Minto (tasktop.com) 



247731 1.6K 
[Browser] Eclipse requires restart after changing mozilla browser 
location in preferences 
patch 

302529 12.5K 
[UX] [Progress] Show Eclipse IDE progress in the Eclipse icon on the 
Windows 7 Task Bar 
Patch for Job Progress Only 

304716 5.7K 
[UX] [Progress] Show Eclipse startup progress in the Eclipse icon on 
the Windows 7 Task Bar 
updated patch 

Mike Morearty (morearty.com) 

199288 10.7K 
Expressions view should support paste 
Suggested patch 

255310 5.8K 
Launching only gets the progress bar to 91% 
Proposed patch 

271411 4.4K 
Add Watch Expression Dialog won't dismiss with enter 
Proposed patch: changes "Hint:" to "Tip:", changes Shift+Return to 
Ctrl+Return, and doesn't hard-code keysequence text 

276162 909 
[KeyBindings] Exporting key preferences to CSV does not warn of 
overwriting file 
Proposed patch 

Simon Muschel (gmx.de) 

258493 1.9K 
[Dialogs] Ampersand in path not rendered in Open Resource dialog 
Patch for FilteredItemsSelectionDialog 

Benjamin Muskalla (eclipsesource.com) 

73683 13.4K 
[Apply Patch] Add URL option Apply Patch dialog 
applypatch_handle_url.diff 

Danail Nachev (prosyst.bg) 

109898 766 
Intermittent failures in IJobManagerTests relating to job families 
The one-liner fix for the problem 

Peter Nehrer (eclipticalsoftware.com) 

125437 3.7K 
[Commands] handlers: TextActionHandler does not properly maintain 
enablement of its delegate actions 
Proposed patch to fix the outlined problems 

Martin Oberhuber (windriver.com) 

44107 4.5K 
API: Add symbolic links to ResourceAttributes API 
Patch adding the new API 

105554 21.0K 
cyclic symbolic link causes java.lang.OutOfMemoryError: Java heap 
space 



Patch fixing all recursive symbolic link issues in UnifiedTree 

170317 15.7K 
API: Add symbolic links to EFS / IFileInfo APIs 
Final patch tested on Linux 

183137 9.4K 
Contribute liblocalfile native support for solaris-sparc 
Patch with sources adding liblocalfile support for Solaris-sparc 

184433 5.0K 
Contribute symlink-enabled liblocalfile for Linux x86_64 
Patch making EFS aware of the new lib for Linux x86_64 

184534 7.5K 
LocalFileSystem should query available attributes from native lib 
Patch for reading liblocalfile capabilities from native, with fallback 

184534 2.0K 
LocalFileSystem should query available attributes from native lib 
Patch for optimized build in UNIX Makefiles 

210664 8.7K 
Eclipse modifies .project file on project import without reason 
Updated patch against HEAD 

210664 5.4K 
Eclipse modifies .project file on project import without reason 
Patch adding Unittest for the issue 

232426 10.7K 
OutOfMemoryError during Project Refresh due to cyclic symbolic links 
Patch adding a Unittest to core.tests.resources 

232426 6.5K 
OutOfMemoryError during Project Refresh due to cyclic symbolic links 
Patch fixing the issue 

245937 5.7K 
Avoid unnecessary work when ProjectDescription#setLinkLocation() 
does not change anything 
Patch for the enhancement 

249307 1.8K 
Improve the algorithm for ignoring line end changes in 
FileSystemResourceManager#descriptionChanged() 
Patch against 3.5m2 

249316 869 
[efs] On NFS folders on Linux, IFileInfo.getLength() != EFS.NONE 
Alternative patch with API specification update 

Hiroyuki Okamoto (us.ibm.com) 

237273 4.4K 
[About] About dialog does not change about.mappings for dynamic 
product 
Proposed fix 

Eugene Ostroukhov (symbian.org) 

287887 11.5K 
[Wizards] [api] Cancel button has two distinct roles 
Patch that adds a new stop image to fix alignment 

Andrew Overholt (redhat.com) 

274373 1.3K 
[Metadata] Some testing data folders not parametrized 
another patch 

Chris Paton (chrispaton.co.uk) 



150591 710 
[Patch] Team -> Apply Patch and line endings 
Proposed patch against CVS head 

Snehasish Paul (in.ibm.com) 

278290 21.2K 
[Intro] Make the RSS news reader reusable 
Updated with comment #4 suggested changes - patch 1 

Jim Perry (us.ibm.com) 

227252 72.5K 
[Help] Enhancement: Remote Assistance: Add HTTPS support 
Patch for HTTPS support including doc patch, 2010 copyrights, support 
for no protocol specified 

237098 2.7K 
[Help] Adding Remote Help Content not available in Help 
WAR/Infocenters 
Patch for org.eclipse.help.webapp 

237098 1.5K 
[Help] Adding Remote Help Content not available in Help 
WAR/Infocenters 
Patch for org.eclipse.help.base 

280354 46.9K 
[Help] Action for doc plugins that reside locally and remotely 
Patch for remote ordering 

281145 5.7K 
[CheatSheet] Simple mechanism to publish internal resources of 
cheatsheet plugin via http urls 
Patch for org.eclipse.ui.browser 

303371 1.1K 
Protocol comes through as space character instead of HTTP when 
protocol preference is space 
Patch for this space character issue 

305711 2.9K 
[Help] Content preference page needs UI polish 
Patch fixing gray sliver on the preference page 

305743 1.2K 
[Help] Add back the old constructor to RemoteIC 
Patch for adding the old constructor 

311404 1.3K 

Remote help priority checks for null InputStream to determine if Doc is 
on remote infocenter even though InputStream for Topic Not Found 
page is returned 
Patch for Checking if rtopic path when page is not found 

312662 774 
[Help] TVT36:TCT239: CHS: Duplicate Mnemonic 
Patch with C used as the Mnemonic key 

Carsten Pfeiffer (gebit.de) 

259536 4.5K 
[EditorMgmt] [Patch] Problems reloading a bundle 
Fixes support for reloading of editor extensions 

Ian Phillips (ianp.org) 

258016 1.7K 
[PropertiesView] NPE in 
org.eclipse.ui.views.properties.PropertySheetViewer 



Patch that removes copy/paste artefacts as well as improving code 
safety. 

264336 8.6K 
[Contributions] [expressions] RFE: CountExpression should support 
additional options. 
CDC-1.0 compliant workspace patch 

Pawel Pogorzelski (pl.ibm.com) 

50260 11.5K 
[History View] CVS Resource History doesn't persist UI 
Patch_v05 

80577 13.6K 
[Repo View] Author not shown in remote compares 
Patch_v01 

108611 5.8K 
[Tags] Provide for viewing last 20 tags when tagging 
Patch 

150591 1.3K 
[Patch] Team -> Apply Patch and line endings 
Patch for test cases 

176690 5.9K 
[Edit] The compare editor should be reconciled with other editors 
Patch_v02 

183226 47.8K 
[Apply Patch] API to instantiate and apply arbitrary IHunks 
Patch_v04 

183238 29.8K 
[Apply Patch] API to get IHunks from IFilePatch and select which of 
them to apply 
Patch_v04 

195495 12.9K 
[Viewers] Add option to do nothing on reaching the end 
Patch_v04 

203812 5.0K 
localfile_1_0_0.dll for 64-bit Windows on x86_64 
Patch_v01 

205817 2.5K 
[Wizards] Finish in Change ASCII/Binary does nothing if comment 
required 
Patch 

214105 3.4K 
[Patch] Enablement of "OK" button on the Save Patch dialog 
Patch 

223857 21.1K 
[Viewers] Should be able to set the encoding of text pane in compare 
editor 
223857_v09_R3_4 

223857 14.7K 
[Viewers] Should be able to set the encoding of text pane in compare 
editor 
Patch_v05 

228000 10.5K 
[Tests] Add tests for the "Count lines in the patch" feature 
Patch_v05 

228739 87.4K [Proxy] add UI support to see what the automatically detected proxy 



settings are 
Patch_v02 

232495 3.3K 
[Proxy] Gnome library should not blow up Eclipse w/o Gnome 
Patch_v02 

232600 1.0K 
Export Team Project Set dialog stuck with folder error message 
Patch 

236439 6.2K 
[Viewers] Provide some way to hide outgoing annotations 
Patch_v01 

238796 2.0K 
[Net] JSch non-proxy list should be considered case insensitive 
Patch_v3 

238877 835 
[Wizards] Team/"Share Project" with an existing one does not support 
CVS-branches anymore 
Patch_v02 

240856 2.8K 
[Net] Enable automatic proxy detection from the system 
Patch 

241214 6.3K 
[Patch] An error while saving a patch file 
Patch 

241216 1.6K 
[Patch] Sort order in the Save Patch dialog 
Patch 

241649 2.4K 
[Dialogs] Resizing of the "compare with other" dialog 
Patch_v02 

243587 3.1K 
[Patch] 'Create Patch' wizard allows the target folder to be a closed 
project 
Patch 

244397 2.2K 
[Tests] Net test failures in N20080814-2000 
Patch 

244527 1.0K 
[Net] Assertion in the NetTest.setProxiesEnabled(boolean) method is 
errorprone 
Patch 

245845 829 
[Net] Fragment org.eclipse.core.net.linux.x86 version number needs an 
update 
Patch_v01 

245849 27.4K 
[Net] Native file getproxygnome.c doesn't match library name 
libproxygnome.so 
Patch_v01 

245850 3.6K 
[Net] Header generated for JNI from UnixProxyProvider is missing 
Patch_v01 

245854 9.7K 
[Net] Windows native header file's name too long 
Patch_v02 



245877 1.1K 
[Net] Change "No Proxy for" to "No proxy for", "User Name" to "User 
name" in Window -> Preferences -> Network Connections 
Patch_v01 

246065 12.0K 
[Net] Unexpected error encountered while preparing for the operation 
Patch_v05 

246072 11.0K 
[Net] Native proxy libraries support for getting native provider name 
Patch_v03 

247408 6.7K 
[Net] Deprecate getProxyDataForHost(String) in the IProxyService API 
Patch_v02 

247815 1.6K 
[CVS UI] Correct typo in method in UserInfoPrompter 
Patch_v01 

248210 1.7K 
[Net] Consistent crashes from UnixProxyProvider 
Patch_v01 

249448 797 
[Net] Errors in native proxy code execution obstruct Eclipse start 
Patch_v01 

249733 4.3K 
[Net] System proxy providers should use constants 
Patch_v02 

249954 777 
[Patch] "Create Patch" creates invalid file if a new file ends with no 
newline 
Patch_v01 

252086 1.7K 
[Viewers] Text compare is not visible when editor background color is 
set to gray 
Patch 

255088 1.6K 
[Net] Malformed \uxxxx encoding exception in 
UnixProxyProvider.getEnv() 
Patch_v02 

255616 23.9K 
[Net] Add proxy providers layer on the top of ProxyManager 
Patch_v01 

255814 13.5K 
[Net] Wrong methods and types used in org.eclipse.core.net 
Patch_v03 

255836 1.3K 
[Net] Wrong method used in org.eclipse.ui.net 
Patch_v02 

255959 2.7K 
[Net] Windows IE setting "Use the same proxy server for all protocols" 
is not consumed by Eclipse 
Patch_v02 

255981 2.3K 
[Net] Setting direct provider on ProxySelector doesn't affect 
ProxyManager 
Patch_v01 

256080 941 [Net] New UI for proxy preferences show password in plain text 



Patch_v01 

256081 18.3K 
[Net] Remove unnecessary API from IProxyData 
Patch_v02 

257172 1.8K 
[Net] Get rid of System.getenv(String) invocation 
Patch_v01 

257199 3.7K 
[Sync View] Incomplete labels in compare editor 
Patch_v01 

257420 33.3K 
[Net] "System proxy configuration" option not working under Vista 
x64. 
Patch_v01 

257503 11.3K 
[Net] Switching to Native proxy provider doesn't clear system 
properties 
Patch_v03 

258941 1.5K 
[Net] Unknown process error 
Patch_v01 

259362 3.9K 
[Edit] Update diffs after undo 
Patch_v01 

259940 4.0K 
[Viewers] Document providers are not used when comparing revisions 
from CVS 
Patch_v01 

260541 1.3K 
[Proxy] Eclipse CVS connections fail with the "Eclipse" Proxy provider 
Patch_v01 

261025 6.3K 
[Viewers] Changing encoding in compare editor doesn't trigger 
structured differences recalculation 
Patch_v03 

261430 1.0K 
[Viewers] IllegalArgumentException while comparing in the sync view 
Patch_v01 

263220 1.8K 
[Viewers] Buttons for copying from left to right are present when 
opening a compare editor from a sync view 
Patch_v01 

265277 4.6K 
[Net] Unknownhostexception: http 
Patch_v01 

265491 905 
[Net] Redundant setProxiesEnabled() or bug? 
Patch_v01 

265740 3.9K 
[Apply Patch] Opening a patch that will create a file logs 
ResourceExceptions 
Patch_v02 

265824 4.5K 
[Apply Patch] API to get lines from IHunks 
Patch_v03 



265839 1.1K 
[Proxy] NPE from IProxyData.setHost 
Patch_v01 

265955 11.8K 
[Apply Patch] FileDiff should be the only class directly implementing 
IFilePatch2 
Patch_v04 

265957 2.2K 
[Net] ProxyType.setProxyData(...) contains parameter that is never used 
Patch_v01 

266812 13.9K 
[Tests] Add tests for creating/applying patches from UI 
Patch_v03 

266812 20.1K 
[Tests] Add tests for creating/applying patches from UI 
Patch_B_v02 

266812 629 
[Tests] Add tests for creating/applying patches from UI 
Patch_B_v03 

267020 66.3K 
[Apply Patch] Rename FileDiffWrapper to FilePatch and FileDiff to 
FilePatch2 
Patch_v01 

267817 1.4K 
[Patch] Inform user if changes are not included in the patch 
Patch_v01 

268355 2.7K 
[Net] checkboxes cut off in Network Connections preference page 
Patch_v01 

268474 1.5K 
[Net] CVS connections fail with the "Native" Proxy provider 
Patch_v01 

269495 1.5K 
[Preferences] Compare/Patch preview on preference page: Set 
Encoding... throws AFE 
Patch_v02 

270458 8.5K 
[Net] Untranslated combo on Network Connections pref page 
Patch_v02 

Sergey Prigogin (gmail.com) 

261457 3.3K 
URIUtil.toPath(URI uri) discriminates against user-defined filesystems 
Fix + extended test case 

Kaloyan Raev (sap.com) 

284540 2.5K 
[Net] Changing nonProxiedHosts does not update the system properties 
unit test 

Nicolas Richeton (gmail.com) 

271416 1.7K 
VersionNumberStripper fails with underscores in path 
Fix for underscores in path 

Eric Rizzo (rizzoweb.com) 

162102 26.5K [Workbench] User configurability for 



MAX_RECENT_WORKSPACES 
Patch that includes Help changes and externalizes the UI strings 

262016 3.6K 
[Snippets][Viewers] Snippet to demonstrate a combined 
TextAndDialogCellEditor 
The cell editor class 

262016 6.1K 
[Snippets][Viewers] Snippet to demonstrate a combined 
TextAndDialogCellEditor 
The snippet class that demonstrates the cell editor 

268819 1.3K 
[WorkbenchLauncher] 'Workspaces' preference page's 'Remove' button 
should enable/disable itself more intelligently 
Patch against org.eclipse.ui.ide.application 

276755 9.4K 
[DataBinding] Snippet to demonstrate data binding a ComboViewer to 
an enum 
Patch against HEAD of project org.eclipse.jface.examples.databinding 

Randy Rohrbach (Windriver.com) 

272367 2.4K 

"Show Type Names" attribute is not available in the 
IPresentationContext properties 
Sets DISPLAY_VARIABLE_TYPE_NAMES property in the 
presentation context 

Izzet Safer (ca.ibm.com) 

250505 881 
[Forms] AbstractHyperlink should check if widget is disposed before 
calling triggerAccessible 
proposed patch 

Shuichi Saitoh (jp.ibm.com) 

306314 9.2K 
Three-way merge wrongly detects conflict to adjoining (not 
overlapping) changes 
Patch to HEAD (13/04/2010) (testcase included) 

Nick Sandonato (us.ibm.com) 

254522 999 
XMLContentDescriber guesses charset incorrectly for unterminated 
encoding value 
patch for encoding guessing 

Leo Dos Santos (tasktop.com) 

211361 1.1K 
GraphicsExample crashes 
patch to GC 

Dina Sayed (eg.ibm.com) 

269844 15.6K 
[GlobalActions] "Close Unrelated Projects" is dangerous and needs 
confirmation 
Modifed patch 

269844 899 [GlobalActions] "Close Unrelated Projects" is dangerous and needs 



confirmation 
Documentation update for ref-9.htm 

276324 2.7K 
[ViewMgmt] CycleBaseHandler throws NPE if no workbench parts 
available 
Proposed patch 

Michael Scharf (windriver.com) 

240562 649 
[DataBinding] Strange constants in StringToNumberConverter 
comment #0 

240562 386 
[DataBinding] Strange constants in StringToNumberConverter 
comment #3 

Kai Schlamp (gmx.de) 

271148 3.7K 
[DataBinding] UpdateStrategy Policies not working as expected 
Fix 

Markus Schorn (windriver.com) 

108066 1.7K 
[prefs] core.prefs settings file causing repeating version conflicts 
Clears the dirty flag after updating project prefs from file 

284447 10.8K 
[Workbench] Add custom workspace name in front of the Workbench 
window title 
Implements a workspace preference for a workspace name 

306575 16.6K 
Allow project to reference a refresh snapshot for use with standard 
import 
patch 

Mike Schrag (pobox.com) 

86745 3.7K 
Tree shows horizontal scrollbar although not required 
Patch for Carbon (on 10.5) 

Nikolaj Schumacher (nschum.de) 

153432 17.1K 
[KeyBindings] Unicode keyboards on Mac OSX produce wrong keys 
when used with modifiers 
patch for 3325 

Max Stepanov (gmail.com) 

260076 325 
Infinite loop in Tree.clearCustomWidths() 
Patch to fix the bug 

Calman Steynberg (gmail.com) 

86745 826 
Tree shows horizontal scrollbar although not required 
Patch for the new Cocoa implementation to auto hide scrollbars in trees 

210858 1.4K 
Editing text has no horizontal scrollbar 
Patch without debug statements 



Rob Stryker (jboss.com) 

243824 9.4K 
[CommonNavigator] lacks table / tree-table support 
More full patch 

250198 1.3K 
[CommonNavigator] Allow CommonNavigator to be subclassed 
Patch 

261506 1.4K 
[CommonNavigator] NavigatorDNDService seems like it can use only 
interfaces 
CommonDropAdapter has a bad cast 

Remy Suen (ca.ibm.com) 

43573 3.5K 
[Contributions] Support icon in <menu> 
Patch to add an 'icon' attribute to the 'menu'. 

85708 954 
[KeyBindings] preference page: Export button is poorly named 
Patch to elaborate on the button's text. 

175069 5.7K 
[Preferences] ResourceInfoPage is not setting dialog font on all widgets 
Patch to use Dialog's static applyDialogFont(Control) method. 

201663 1.5K 
[WorkingSets] Working set selection dialog in Project Explorer has 
conflicting mnemonic keys 
Set other mnemonic keys so that they don't conflict with each other. 

204879 8.5K 

[LinkedResources] PathVariableDialog's button positioning is 
confusing 
Patch to implement the behaviour on the third image, putting the 
buttons on the same line as the 'Location' text field. 

208804 1.8K 
[CommonNavigator] change "Navigator" view perspective links 
Patch to change the perspective to point at the 'Project Explorer' as 
requested. 

221652 1.9K 
[Patch] Widgets layout on Advanced Options page in the Create Patch 
wizard 
Patch to use the same amount of vertical spacing in both groups. 

221973 47.5K 
Make WorkingDirectoryBlock from JDT a Debug API class 
org.eclipse.debug.ui.WorkingDirectoryBlock public API patch v1 

238862 854 
org.eclipse.ui.tests needs to set a proper JRE in its .classpath file 
Patch to fix the project's .classpath file. 

244303 4.0K 
Export 'Team Project Set' wizard's workspace file selection user 
interface could be improved 
Patch to correct the two problems described. 

244694 1.1K 
Conflicting mnemonics in breakpoints export wizard 
Patch to correct the mnemonic conflict. 

Mohamed Tarief (eg.ibm.com) 

139211 2.8K "Open Referenced Projects" dialog pops up even when there are no 



referenced projects 
Suggested fix to the bug 

174481 1.9K 
[ViewMgmt] Show View dialog selects wrong entry on Enter 
suggested fix to the pack (2) 

Tristan Tarrant (gmail.com) 

273072 14.3K 
[Net] Provide native proxy support on x86_64 Linux 
atch which adds a x86_64 fragment and makefile for building the native 
library (update 1) 

Patrick Tasse (gmail.com) 

282046 1.0K 
[MPE] MultiPageEditorSite does not remove properly its 
KeyBindingService 
Proposed patch in MultiPageEditorSite.dispose() 

Grant Taylor (ca.ibm.com) 

250107 1.5K 
Build order incorrect when project is deleted 
comment #7 

Roland Tepp (videobet.com) 

107197 5.6K 
[Forms] MasterDetailsBlock should not make assumptions on the way it 
should be laid out. 
Backwards compatible patch to MasterDetailsBlock 

Randall Theobald (us.ibm.com) 

247689 6.2K 
performance issues in ContentDescriptionManager/XMLRootHandler 
revised patch 

Andi Thomas (csc.com) 

231327 1.2K 
Tabbing into table sets focus to first column regardless of its visibility 
Changes as a patch  

Trevor (gmail.com) 

156152 15.8K 
[Sync View] Schedule a synchronize at night 
Patch adds 2 checkboxes for "Immediately" and "Run Once" and fixed 
prior issues 

Ben Vitale (yahoo.com) 

263100 1.2K 
[DataBinding] TitleAreaDialogSupport documentation nits 
Revised patch 

264519 1.0K 
[ActivityMgmt] Pref page activity manager listener not detached 
Patch to remove the listener 

Elias Volanakis (eclipsesource.com) 

271720 2.6K 
[DataBinding] Clarify DateTimeSelectionProperty javadoc with respect 
to null values 



Javadoc patch 

Gunnar Wagenknecht (wagenknecht.org) 

265445 1.2K 

Message "Authorization infrastructure 
(org.eclipse.core.runtime.compatibility.auth) not installed." logged 
multiple times 
Patch for org.eclipse.core.runtime to log the message only once 

Stephan Wahlbrink (wahlbrink.eu) 

200997 3.0K 
[Progress] Can't seem to cancel jobs from ProgressView 
Patch fixing it on jobs level 

200997 3.0K 
[Progress] Can't seem to cancel jobs from ProgressView 
Patch for automatic tests 

200997 3.7K 
[Progress] Can't seem to cancel jobs from ProgressView 
Fix and extended test that canceling() is called only the first time 

227534 5.5K 
[misc] Annotations not painted when length is 0 / at document end 
Patch (incl. renamed function, javadoc, copyright) 

Rich Watts (us.ibm.com) 

317055 1.4K 
[webapp] URLEncode url requests from local users 
FramesetFilter Patch with suggested urlencode 

Wayne (ca.ibm.com) 

243209 914 
[ActivityMgmt] NPE in org.eclipse.ui.internal.activities.Identifer 
prevents menu contributions from showing up 
Patch to fix the problem. 

Mateusz Wenus (gmail.com) 

259442 4.9K 
[Debug] Add a Copy/Paste context menu in the "Add watch expression" 
window 
patch 

Ryan Wilhm (aim.com) 

253065 852 
Window -> Show View -> Other ... is broken 
Patch to fix ClassCastException on filtered view dialog 

David M Williams (us.ibm.com) 

238334 3.4K 
There seems to be no deleted content in cvs 
Fix v02 

Mario Winterer (scch.at) 

245675 7.7K 
[Viewers] Code snippet that attaches content assist to a CellEditor 
Shows how to attach content assist to a text cell editor 

288216 4.5K 
PropertyTester org.eclipse.core.resources.contentTypeId should test 
hierarchy, not just equality 



Patch that tests for hierarchy only if certain argument is specified 

Aleksandra Wozniak (gmail.com) 

73923 28.2K 
[Actions] Add "compare with arbitrary file" 
patch #6 

239959 28.7K 
Adding content to "Compare with other resource" dialog by 
drag&dropping 
patch #8 

240294 1.5K 
Unused class in source code 
Removes Messages.java from org.eclipse.compare.internal 

241539 1.9K 
Key binding for "Compare with Other" dialog 
patch #1 

243873 1.5K 
NPE in "Compare with Other" dialog 
patch #1 

244623 974 
Cannot perform compare from "Compare with Other" dialog 
patch #1 

Stefan Xenos (gmail.com) 

206169 1.6K 
[Forms] SharedScrolledComposite introduces flicker 
Patch that fixes the flicker and reveals the performance problem. 

Sky Yan (cn.ibm.com) 

210430 3.4K 
Shell.setMenuBar() does not work 
loading NIB method 

211865 712 
Tooltip always prompt up in the wrong place 
patch for tooltip position issue 

Wang Yizhuo (gmail.com) 

239178 810 
[Forms]FormPage header cannot render horizontal gradient 
Patch 

Fabio Zadrozny (gmail.com) 

265049 2.0K 
[CommonNavigator] ClassCastException from 
WorkingSetFilterActionGroup (that should not happen) 
Patch removing those casts 

270385 42.8K 
[typing] HippieCompleteAction is slow ( Alt+/ ) 
Patch v4 

Sascha Zak (zak-digital.de) 

282874 2.0K 
[ViewMgmt] [ActivityMgmt] NullpointerException during saving state 
of view registry with disabled xp based activities 
Patch for both ViewFactory and Perspective null check 

Simon Zambrovski (gmail.com) 



274089 52.3K 
[CommonNavigator] Improve CNF documentation 
CNF EclipseDoc proposal 

Hao Zhang (cn.ibm.com) 

76005 70.1K 
[Help] Ability for users to filter what they see in the help system 
navigation acc to some criteria (all help modes) 
Filtering(Criteria and content scope) in search results-- backend 

76005 161.7K 
[Help] Ability for users to filter what they see in the help system 
navigation acc to some criteria (all help modes) 
Filtering(Criteria and content scope) in search results-- backend & UI 

293744 16.2K 
[Webapp]Allow additional section to be added to the bar upside 
Patch V1 

293745 15.8K 
[Help][Search]Provide enhancement for quick search function 
Patch V1 

293745 561 
[Help][Search]Provide enhancement for quick search function 
Additional button image 

293747 28.4K 
[Help][Print]Add maximum printed topics and maximum connections to 
the preference to optimize the quick print operation 
Patch V3 

296506 859 
[Webapp] Quick search of Toc only searches subtopics 
Patch V1 

Stefan Rock (cas.de) 

256889 5.2K 
[Viewers] [table] IAE (Index out of bounds) after selecting rows in 
virtual TableViewer 
Testcase for bug 

Richard Hofter (web.de) 

203522 63.2K 
Export Ant buildfiles: Including a user specific buildfile in build.xml 
doesn't work 
Fixed source 

Jordi Bohme Lopez (eclipsesource.com) 

199022 3.5K 
Updatemanager Digest generates invalid xml 
Patch against org.eclipse.update.core 

sheila (cn.ibm.com) 

259545 13.4K 
[Webapp] API to allow user defined filters to process the files sent from 
the server 
Patch for adding extra filters 

Repositories 
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